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ABSTRACT:

The electrical grid connects all producing stations to provide customers with uninterruptible
electricity. Smart sensors and communication are being combined with the existing grid to mimic the
behavior of a smart system as technology advances. This smart grid provides two-way
communication between customers and producers. It is a smart network that connects energy
generation, transmission, substations, and distribution, among other things. This smart grid provides
clean, dependable power at a high transmission efficiency rate. This research proposes a highly
efficient smart management system for a smart grid with comprehensive protection. This management
system examines and monitors the parameters on a regular basis. This futuristic technology also
creates a smart transformer with alternating current and direct current compatibility for self-protection
and healing.

I.INTRODUCTION

Nowadays, the electric power infrastructure is particularly sensitive to a wide range of natural and
malevolent physical occurrences, which can have a negative impact on the grid's overall performance
and stability. Furthermore, there is an approaching need to replace the ageing transmission line
infrastructure with a high-performance data communication network capable of supporting future
operational requirements such as real-time monitoring and control required for smart grid integration.
Several electric power transmission companies have depended heavily on circuit indicators to detect
broken transmission line sections. Unfortunately, pinpointing the specific position of these defects
remains difficult. Although fault indicator technology has made it possible to find permanent
problems, the technical staff and patrol teams must still physically patrol and examine the devices for
extended periods of time to detect problematic parts of their transmission lines. Wireless sensor-based
transmission line monitoring addresses several of these concerns, including real-time structural
awareness, faster fault localization, accurate fault diagnosis by identifying and distinguishing
electrical faults from mechanical faults, cost reduction due to condition-based maintenance rather
than periodic maintenance, and so on. Some applications have rigorous requirements, such as the
rapid transmission of massive amounts of extremely trustworthy data. The success of these
applications is dependent on the development of a low-cost, dependable network architecture with a
rapid reaction time. The network must be capable of transporting sensitive data such as transmission
line status and control information to and from the transmission grid. This study proposes a cost-
effective methodology for designing a real-time data transmission network. Sensors are installed in
various components of the power network to monitor the state of the power system in real time. These
sensors can take fine-grained measurements of a range of physical or electrical properties and create
a large amount of data. Providing this information to the control centre in a cost-effective and timely
way is a significant difficulty that must be overcome to construct an intelligent smart grid. Because

@2023, IJETMS | Impact Factor Value: 5.672 | Page 281



Website: ijetms.in Issue: 3 Volume No.7 May - June — 2023

w International Journal of Engineering Technology and Management Sciences
DOI1:10.46647/ijetms.2023.v07i04.039 ISSN: 2581-4621

to the massive scale, extensive terrain, unusual topology, and essential time requirements, network
architecture is a vital part of sensor-based transmission line monitoring. Mechanical issues, cost
savings via condition-based maintenance rather than routine maintenance, and so on.

ILEXISTING AND PROPOSED SYSTEM

The tracer technique is a comprehensive approach for locating a faulty segment by travelling through
the wire circuits. A faulty segment can be identified via aural or electromagnetic signals, necessitating
the dispatch of staff members to the outage location. Several strategies have been widely employed
in industry, including the tracing approach by acoustic, electromagnetic, or current. The terminal
approach is a methodology for determining the location of a failure in a distribution cable network
from one or both ends without thorough tracing. One of the most used terminal methods is the bridge
technique, which connects with a resistor to locate a defect. It is a technique for detecting cable faults
from one or both ends without tracing.

The proposed project effort focuses on monitoring high transmission line towers. We examine
several types of defects for monitoring purposes. The Node MCU may broadcast data to a web page
through the Wi-Fi module and set a limit for each failure. If any of the parameters exceeds its limits,
the system sends a warning message to the authority's cell phone. The overhead transmission line
monitoring system is analyzed by comparing the estimated values with the actual observed data using
a theoretical equation. Furthermore, the suggested system might collaborate with 10T systems to
increase its feasibility and practicability. The data from the numerous sensors is relayed through Wi-
Fi and saved in a database. This fault information might be sent to power companies to improve
transmission line safety or used as a reference in a power dispatch center. Every hour on the hour, all
data from the overhead transmission line is captured. When a defect arises in a transmission line, it
requires time and money to repair it. There is also the chance of living being life. The application of
I0T in transmission lines will assist to enhance transmission line monitoring and maintenance. It will
also increase efficiency, cut labour costs, and save time in transmission line maintenance.

I1l. BLOCK DIAGRAM
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Fig 1: Block Diagram
IV. HARDWARE REQUIREMENTS
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NODE MCU ESP8266

ESP8266 is a single 2.4 GHz Wi-Fi-and-Bluetooth combo chip designed with the TSMC ultra-low-
power 40 nm technology. It is designed to achieve the best power and RF performance, showing
robustness, versatility and reliability in a wide variety of applications and power scenarios.

The ESP8266 series of chips includes ESP8266-DOWD-V3, ESP8266-DOWDQ6-V3, ESP8266-
DOWD, ESP8266-DOWDQ6, ESP8266-D2WD, ESP8266-SOWD, and ESP8266-U4WDH, among
which, ESP8266-DOWD-V3, ESP8266-DOWDQ6-V3, and ESP8266-U4WDH are based on ECO V3
wafer.
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Fig 2 NODE MCU ESP8266
Featured Solutions:
» Ultralow Power Solution
ESP8266 is designed for mobile, wearable electronics, and Internet-of-Things (10T) applications. It
features all the state-of-the-art characteristics of low-power chips, including fine-grained clock
gating, multiple power modes, and dynamic power scaling. For instance, in a low-power 10T sensor
hub application scenario, ESP8266 is woken up periodically and only when a specified condition is
detected. Low-duty cycle is used to minimize the amount of energy that the chip expends. The output
of the power amplifier is also adjustable, thus contributing to an optimal trade-off between
communication range, data rate and power consumption.
» Complete Integration Solution
ESP8266 is a highly integrated solution for Wi-Fi-and-Bluetooth loT applications, with around 20
external components. ESP8266 integrates an antenna switch, RF balun, power amplifier, low-noise
receive amplifier, filters, and power management modules. As such, the entire solution occupies
minimal Printed Circuit Board (PCB) area. ESP8266 uses CMOS for single-chip fully-integrated
radio and baseband, while also integrating advanced calibration circuitries that allow the solution to
remove external circuit imperfections or adjust to changes in external conditions. As such, the mass
production of ESP8266 solutions does not require expensive and specialized Wi-Fi testing equipment.
Wi-Fi Key Features
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v/ 802.11 b/g/n

v/ 802.11 n (2.4 GHz), up to 150 Mbps

v WMM

v TX/RX A-MPDU, RX A-MSDU

v Immediate Block ACK

v’ Defragmentation

v Automatic Beacon monitoring (hardware TSF)

v 4 x virtual Wi-Fi interfaces

v’ Simultaneous support for Infrastructure Station, SoftAP, and Promiscuous modes Note that when
ESP8266 is in Station mode, performing a scan, the SoftAP channel will be changed.
v Antenna diversity

BT Key Features

* Compliant with Bluetooth v4.2 BR/EDR and BLE specifications

* Class-1, class-2 and class-3 transmitter without external power amplifier
* Enhanced Power Control

* +12 dBm transmitting power

* NZIF receiver with —94 dBm BLE sensitivity

* Adaptive Frequency Hopping (AFH)

» Standard HCI based on SDIO/SPI/UART

* High-speed UART HCI, up to 4 Mbps

* Bluetooth 4.2 BR/EDR BLE dual mode controller

« Synchronous Connection-Oriented/Extended (SCO/eSCO)

* CVSD and SBC for audio codec

* Bluetooth Piconet and Scatternet

 Multi-connections in Classic BT and BLE

* Simultaneous advertising and scanning

MCU and Advanced Features:

CPU and Memory:

* Xtensa® single-/dual-core 32-bit LX6 microprocessor(s), up to 600 MIPS (200 MIPS for ESP8266-
SOWD/ESP8266-U4WDH, 400 MIPS for ESP8266-D2WD)

* 448 KB ROM

* 520 KB SRAM

* 16 KB SRAM in RTC

* QSPI supports multiple flash/SRAM chips

Clocks and Timers:

* Internal 8 MHz oscillator with calibration

* Internal RC oscillator with calibration

* External 2 MHz ~ 60 MHz crystal oscillator (40 MHz only for Wi-Fi/BT functionality)
* External 32 kHz crystal oscillator for RTC with calibration

* Two timer groups, including 2 x 64-bit timers and 1 x main watchdog in each group
* One RTC timer

* RTC watchdog

Advanced Peripheral Interfaces

* 34 x programmable GPIOs

* 12-bit SAR ADC up to 18 channels

« 2 x 8-bit DAC

* 10 x touch sensors

* 4 x SPI

«2 XIS

«2x12C

* 3 x UART
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* 1 host (SD/eMMC/SDIO)

* 1 slave (SDIO/SPI)

* Ethernet MAC interface with dedicated DMA and IEEE 1588 support
» Two-Wire Automotive Interface (TWAI®, compatible with 1ISO11898-1)
* IR (TX/RX)

* Motor PWM

* LED PWM up to 16 channels

* Hall sensor

Security

* Secure boot

* Flash encryption

* 1024-bit OTP, up to 768-bit for customers

* Cryptographic hardware acceleration: — AES — Hash (SHA-2)

— RSA — ECC — Random Number Generator (RNG)

Embedded Flash
Bluetooth | Biuetooth RF
1 e baseband receive
SPI e
Clock = =
3 [+
12C generator | |7 @
— . Wi-Fi
128 AL baseband RF |
transmit
Mt
SDIO
UART Core and memory Cryptographic hardware
I Wi
N— 2 (or 1) x Xtensa® 32- = cz.a%rn:zziepl'erati|:)n

TWAI® bit LX6 Microprocessors

SHA RSA
— \—

ETH
ROM SRAM
AES RNG
IR
PWM
RTC
Touch sensor
—_—
uLp Recovery
DAG PMU
coprocessor memory
ADC
2
S
a =z = o @ b4
T 8 £ J JA8REB 2%
338 k&9 58883 ¢
3 5 % % 3 2 9 3 5
vooa 1} : i i3 cPioes
|y T H e
wa N 2f 7 : i i las cro18
| .
vDD3P3 3| ! \_|34 GPIOS
i
voDaPa 4| : i 133 sD_DATA1
-
SENSOR.VP 5| 1 32 SD_DATAO
| i e
SENSOR_CAPP u:f:j : — e SD_CLK
SENSOR CAPN 7] 1 49GND i a0 spemp
| P
SENSOR VN 8| : {7120 sp.DATA 3
i -
CHIP_PU 9] ! 28 SD_DATA 2
| S [
VDET 1 10} : : | 127 cPO17
| ' H .
VDET_2 11} : : ! i_i26 vDD_SDIO
U f
2K X 12) 2 H 25 GPIO16

]
Q
a
S

Qo
a
(o]

Fig 4 Pin Layout

CPU and Memory:
CPU:
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ESP8266 contains one or two low-power Xtensa® 32-bit LX6 microprocessor(s) with the following
features:

» 7-stage pipeline to support the clock frequency of up to 240 MHz (160 MHz for ESP8266-SO0WD,
ESP8266-D2WD, and ESP8266-U4WDH)

* 16/24-bit Instruction Set provides high code-density

* Support for Floating Point Unit

* Support for DSP instructions, such as a 32-bit multiplier, a 32-bit divider, and a 40-bit MAC

* Support for 32 interrupt vectors from about 70 interrupt sources The single-/dual-CPU interfaces
include:

* Xtensa RAM/ROM Interface for instructions and data

» Xtensa Local Memory Interface for fast peripheral register access

* External and internal interrupt sources

* JTAG for debugging

Internal Memory:

ESP8266’s internal memory includes:

* 448 KB of ROM for booting and core functions

* 520 KB of on-chip SRAM for data and instructions

* 8§ KB of SRAM in RTC, which is called RTC FAST Memory and can be used for data storage; it is
accessed by the main CPU during RTC Boot from the Deep-sleep mode.

* 8 KB of SRAM in RTC, which is called RTC SLOW Memory and can be accessed by the co-
processor during the Deep-sleep mode.

* 1 Kbit of eFuse: 256 bits are used for the system (MAC address and chip configuration) and the
remaining 768 bits are reserved for customer applications, including flash-encryption and chip-ID.

* Embedded flash

External Flash and SRAM:

ESP8266 supports multiple external QSPI flash and SRAM chips. More details can be found in
Chapter SPI in the ESP8266 Technical Reference Manual. ESP8266 also supports hardware
encryption/decryption based on AES to protect developers’ programs and data in flash.

ESP8266 can access the external QSPI flash and SRAM through high-speed caches.

» Up to 16 MB of external flash can be mapped into CPU instruction memory space and read-only
memory space simultaneously.

— When external flash is mapped into CPU instruction memory space, up to 11 MB + 248 KB can be
mapped at a time. Note that if more than 3 MB + 248 KB are mapped, cache performance will be
reduced due to speculative reads by the CPU.

— When external flash is mapped into read-only data memory space, up to 4 MB can be mapped at a
time. 8-bit, 16-bit and 32-bit reads are supported.

« External SRAM can be mapped into CPU data memory space. SRAM up to 8 MB is supported and
up to 4 MB can be mapped at a time. 8-bit, 16-bit and 32-bit reads and writes are supported.
CURRENT SENSOR

DESCRIPTION

A current sensor is a device that detects and converts current to an easily measured output voltage,
which is proportional to the current through the measured path.

When a current flows through a wire or in a circuit, voltage drop occurs. Also, a magnetic field is
generated surrounding the current carrying conductor. Both of these phenomena are made use of in
the design of current sensors. Thus, there are two types of current sensing: direct and indirect. Direct
sensing is based on Ohm’s law, while indirect sensing is based on Faraday’s and Ampere’s law.
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Fig 5 CURRENT SENSOR

A current sensor (CT1270) is a device that detects electric current (AC or DC) in a wire and
generates a signal proportional to it. The generated signal could be analog voltage or current or even
digital output.

When a current flows through a wire or in a circuit, voltage drop occurs. Also, a magnetic
field is generated surrounding the current carrying conductor. Both of these phenomena are made use
of in the design of current sensors. Thus, there are two types of current sensing: direct and indirect.
Direct sensing is based on Ohm’s law, while indirect sensing is based on Faraday’s and Ampere’s
law. Direct Sensing involves measuring the voltage drop associated with the current passing through
passive electrical components.
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Fig 6 CIRCUIT DIAGRAM OF CURRENT SENSOR
Indirect Sensing involves measurement of the magnetic field surrounding a conductor
through which current passes. Generated magnetic field is then used to induce proportional voltage
or current which is then transformed to a form suitable for measurement and/or control system.

FEATURES

Supply voltage: 5v DC
Output: analog

Small size

Low cost
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APPLICATIONS

e Ammeters

e Current control purposes

e DC/DC converters

e Ground fault detectors

AC DIMMER

The amount of AC voltage that will be applied to any device is managed by the AC light dimmer
module. They can be observed in a light dimmer switch or a fan controller.

The TRIAC BTA16 can transfer current up to 600V/16A, however we do not advise increasing power
to this level. The AC Dimmer is designed to adjust the alternating current voltage, which can transfer
current up to 220V (5A-10A). The majority of the time, a dimmer is used to switch the power ON or
OFF for lighting or heating components, but it may also be utilised with fans, pumps, air cleaners,
etc.

Dimmer has recently developed as a popular option for smart home systems. When you need to
gradually adjust the light brightness, for instance. A cosy ambiance is created by the lamp's gradual
ON/OFF transitions. Filament bulbs are the best choice for dimmer use. With low brightness LED
lighting, it is less steady, but with moderate and high brightness, it will work well. Be aware that gas
discharge lights, often known as luminous lamps, do not support dimming.

To prevent excessive current disturbance to a microcontroller, the power portion of the dimmer is

separated from the control portion.

Fig 7 AC DIMMER

Specification:

e Type: AC light dimmer

Power: up to 220V (5A~10A)

AC frequency: 50/60 Hz

TRIAC: BTA16 — 600B

Logic level: 3.3V/5V

Modulation (DIM/PSM): logic level ON/OFF TRIAC
Signal current: >10mA

Operating temperatures: —20C to 80C,

V.SOFTWATE TOOLS
e EMBEDDED C
¢ ARDUINO IDE
e PHP, MY SQL

@2023, IJETMS | Impact Factor Value: 5.672 | Page 288



r4psy International Journal of Engineering Technology and Management Sciences
3 Website: ijetms.in Issue: 3 Volume No.7 May - June — 2023
DO1:10.46647/ijetms.2023.v07i04.039 ISSN: 2581-4621

ARDUINO IDE:

The Arduino Integrated Development Environment - or Arduino Software (IDE) - contains a text
editor for writing code, a message area, a text console, a toolbar with buttons for common functions
and a series of menus. It connects to the Arduino and Genuino hardware to upload programs and
communicate with them.

Programs written using Arduino Software (IDE) are called sketches. These sketches are written in
the text editor and are saved with the file extension. ino. The editor has features for cutting/pasting
and for searching/replacing text. The message area gives feedback while saving and exporting and
displays errors. The console displays text output by the Arduino Software (IDE), including complete
error messages and other information. The bottom righthand corner of the window displays the
configured board and serial port. The toolbar buttons allow you to verify and upload programs, create,
open, and save sketches, and open the serial monitor.

Before uploading your sketch, you need to select the correct items from the Tools >
Board and Tools > Port menus. The boards are described below. On the Mac, the serial port is
probably something like /dev/tty.usbmodem 241 (for an Uno or Mega2560 or Leonardo)
or /devi/tty.usbserial-1B1 (for a Duemilanove or earlier USB board),
or /dev/tty. USA19QW1b1P1.1 (for a serial board connected with a Keyspan USB-to-Serial adapter).
On Windows, it's probably COM1 or COM2 (for a serial board) or COM4, COM5, COMY7, or higher
(for a USB board) - to find out, you look for USB serial device in the ports section of the Windows
Device Manager. On Linux, it should be /dev/ttyACMXx , /dev/ttyUSBx or similar. Once you've
selected the correct serial port and board, press the upload button in the toolbar or select
the Upload item from the Sketch menu. Current Arduino boards will reset automatically and begin
the upload. With older boards (pre-Diecimila) that lack auto-reset, you'll need to press the reset button
on the board just before starting the upload. On most boards, you'll see the RX and TX LEDs blink
as the sketch is uploaded. The Arduino Software (IDE) will display a message when the upload is
complete or show an error.

EMBEDDED C:

Embedded C is a set of language extensions for the C programming language by the C Standards
Committee to address commonality issues that exist between Cextensions  for
different embedded systems.

Embedded C is a set of language extensions for the C programming language by the C Standards
Committee to address commonality issues that exist between C extensions for different embedded
systems. Historically, embedded C programming requires nonstandard extensions to the C language
in order to support exotic features such as fixed-point arithmetic, multiple distinct memory banks,
and basic 1/0 operations

An embedded system is a computer system with a dedicated function within a larger mechanical or
electrical system, often with real-time computing constraints. It is embedded as part of a complete
device often including hardware and mechanical parts. Embedded systems control many devices in
common use today. Ninety-eight percent of all microprocessors are manufactured as components of
embedded systems.

INTERNET OF THINGS (loT):

The Internet of things (IoT) describes the network of physical objects “things” that are embedded
with sensors, software, and other technologies for the purpose of connecting and exchanging data
with other devices and systems over the Internet.

Things have evolved due to the convergence of multiple technologies, real-time analytics, machine
learning, commodity sensors, and embedded systems. Traditional fields of embedded systems,
wireless sensor networks, control systems, automation (including home and building automation),
and others all contribute to enabling the Internet of things. In the consumer market, 10T technology
is most synonymous with products pertaining to the concept of the "smart home", including devices
and appliances (such as lighting fixtures, thermostats, home security systems and cameras, and other

@2023, IJETMS | Impact Factor Value: 5.672 | Page 289


https://www.arduino.cc/en/Guide/Environment#boards
https://en.wikipedia.org/wiki/C_(programming_language)
https://en.wikipedia.org/wiki/ISO/IEC_JTC_1/SC_22
https://en.wikipedia.org/wiki/ISO/IEC_JTC_1/SC_22
https://en.wikipedia.org/wiki/Embedded_system
https://en.wikipedia.org/wiki/Embedded_system
https://en.wikipedia.org/wiki/Fixed-point_arithmetic
https://en.wikipedia.org/wiki/Memory_bank
https://en.wikipedia.org/wiki/Input/output
https://en.wikipedia.org/wiki/Computer
https://en.wikipedia.org/wiki/System
https://en.wikipedia.org/wiki/Real-time_computing
https://en.wikipedia.org/wiki/Microprocessor

—

Website: ijetms.in Issue: 3 Volume No.7 May - June — 2023

w International Journal of Engineering Technology and Management Sciences
DOI1:10.46647/ijetms.2023.v07i04.039 ISSN: 2581-4621

home appliances) that support one or more common ecosystems, and can be controlled via devices
associated with that ecosystem, such as smartphones and smart speakers. 10T can also be used in
healthcare systems.

The 10T is the strategy for gadgets that encase hardware, and network, which enables these devices
to fix, act together and switch information. 10T incorporates broadening Internet beneficial than
standard gadgets, for example, work areas to any decision of generally non web get to material
gadgets and on a day by day source objects. Inserted through innovation, these gadgets can banter
and coordinate over the Internet, and they can be a little checked and restricted.
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Fig 8 10T IN HEALTH CARE

VI.WORKING METHODOLOGY

Nowadays, the electric power infrastructure is particularly sensitive to a wide range of natural and
malevolent physical occurrences, which can have a negative impact on the grid's overall performance
and stability. Furthermore, there is an approaching need to replace the ageing transmission line
infrastructure with a high-performance data communication network capable of supporting future
operational requirements such as real-time monitoring and control required for smart grid integration.
Several electric power transmission companies have depended heavily on circuit indicators to detect
broken transmission line sections. Unfortunately, pinpointing the specific position of these defects
remains difficult. Although fault indicator technology has made it possible to find permanent
problems, the technical staff and patrol teams must still physically patrol and examine the devices for
extended periods of time in order to detect problematic parts of their transmission lines. Wireless
sensor-based transmission line monitoring addresses several of these concerns, including real-time
structural awareness, faster fault localization, accurate fault diagnosis by identifying and
distinguishing electrical faults from mechanical faults, cost reduction due to condition-based
maintenance rather than periodic maintenance, and so on. Some applications have rigorous
requirements, such as the rapid transmission of massive amounts of extremely trustworthy data. The
success of these applications is dependent on the development of a low-cost, dependable network
architecture with a rapid reaction time. The network must be capable of transporting sensitive data
such as transmission line status and control information to and from the transmission grid. This study
proposes a cost-effective methodology for designing a real-time data transmission network. Sensors
are installed in various components of the power network to monitor the state of the power system in
real time. These sensors can take fine-grained measurements of a range of physical or electrical
properties and create a large amount of data. Providing this information to the control centre in a cost-
effective and timely way is a significant difficulty that must be overcome to construct an intelligent
smart grid. Because to the massive scale, extensive terrain, unusual topology, and essential time
requirements, network architecture is a vital part of sensor-based transmission line monitoring.
Mechanical issues, cost savings via condition-based maintenance rather than routine maintenance,
and so on.
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VII. RESULTS AND DISCUSSION
SIMULATION RESULTS
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VIIl. CONCLUSION

This research presents an ideal formulation for a cost-optimized wireless network capable of
transmitting time-sensitive sensor data across a transmission line network despite latency and
capacity restrictions. Our study demonstrates that a transmission line monitoring framework based
on WSN is technically viable utilizing currently available technology. The proposed method with
formulation is generic and includes variations in several factors such as asymmetric data generation
at towers, wireless link reliabilities, link utilization dependent costs, non-uniform cellular coverage

@2023, JETMS | Impact Factor Value: 5.672 | Page 291



Lays, International Journal of Engineering Technology and Management Sciences
p Website: ijetms.in Issue: 3 Volume No.7 May - June — 2023
DO1:10.46647/ijetms.2023.v07i04.039 ISSN: 2581-4621

characteristics, and cost optimized incremental deployment requirements. According to the
assessment research, the key obstacle in cost reduction is wireless link bandwidth. Furthermore, when
flow capacity increases, the restricted wireless link bandwidth leads to a workable but expensive
design due to greater reliance on cellular networks to meet limits.

IX. FUTURE SCOPE

The future scope of health monitoring system. 10T got multiple benefits such as healing at home,
peace of mind, independent health monitoring and medicines at right time. Multiple parameters like
retinal size, age and weight can be included as controlling parameters in future. This system also
developed by using advanced GSM and GPRS technology in future.
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